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» |[nfroduction

» Method

Figure 2 Cool Mushrooms, TN

» Resulfs

» Conclusions/Discussion

Figure 3 Cool Mushroom pt. 2, TN




Infroduction

Background

» Reclamation of Surface Mined Sites in Southeastern Appalachian region
» Surface Mining Control and Reclamation Act of 1977 (SMCRA)
» Pre-SMCRA reclamation
» Post-SMCRA requirements and shortcomings

» Forestry Reclamation Approach(® .20, 21)

®» Fcosystem Services as metrics for recovery
» Advantages: Communication, Policy Development, Land Management

» Cross-disciplinary benefits







Intfroduction

Background

» FEcosystem Services!l
Provisioning Services Regulating Services Cultural Services
FProducts ablained Eenelits abtained Mewrarmaferial
from ecosystems from requilation of banafits obtalined
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m Sl ferrmation W Mutrient cpcling W Prirfany production

Figure 5 Ecosystem Services,
Figure 2.1 in Assessment (2005)




Infroduction

Where to starte

®» Examining changes over time

= Same type of distfurbance, different pointsin fime & , , Tt N
= Assume sites are similar enough to make meaningful comparisons Figureloiupeic= gl
» Disturbance Types

» Surface-mining

» Clearcut Harvest
» Also a magjor disturbance
» Severe vs. moderate disturbance comparison

= Room for analysis and range of results

» The Goadl

®» Examine a number of ecosystem services to determine the suitability of any one
or more as a metric for site recovery




Intfroduction
Hypotheses

® ]) One or more of the examined ecosystem services will show a significant and
consistent change as age class increases.

» Most important

» ?)Ecosystem services in question will not vary significantly from one another
across disturbance (site) types.

» Metrics should be useful and applicable to a variety of circumstances

» 3)Potential ecosystem service metrics will not show significant variation
between control sites and the final age class.

» Stop-gap to check final age class as an informative stopping point




Infroduction

Tested Ecosystem Services:

» Diameter at Breast Height (DBH) and Species ID (Provisioning/Supporting/Cultural)

» Tree diversity is known to be significant to forest ecosystems®)
» Species diversity and composition is important for stand resistance to disturbance
» Aboveground carbon may be indicative of site recovery®

» Basal Area was also assessed as a potential indicator

» Canopy Cover (Regulating/Supporting)

» Closed canopy creates a microclimate beneath it4
» More stable, and less prone to disturbance by weather, temperature, etc.

» |5 there a relationship between percent canopy cover and recovery?




Infroduction

Tested Ecosystem Services:

» Water Infiltration and Soil Density (Supporting/Regulating)

» \Water must be able to move through an ecosystem, soil must allow for it
» Overly compacted soil imits root growth and water infiltration

» Both very common to selected disturbances

» |nsect Biomass (Regulating/Supporting)

» |nsects are crucial to many ecosystem functions(’)
» May be a useful indicator, both biomass and diversity
» Decomposition Rate (Regulating/Supporting)

» Rate of Decomposition affects carbon cycling

» Can be affected by soil density, moisture, mineral composition, pH, etfc.




Methods
Design and Implementation

» Structure

®» 5 age classes + 1 control category
» Time since last disturbance
= 0-5,6-10, 11-15, 16-29, 30+

» Confrol = undisturbed within 50+ years

» Three plots per age class + two control plots = 32 plots (+1 accidental exira)

= Plots
» 1/10" acre, 37.2ft. Radius, 3 subplots 120° apart
» Subplots Labeled A, B, C, clockwise from A, A almost always uphill or south
» Additional Challenges:
» Minimizing Expense and Complexity
» Covariates — Slope, Elevation
» North Aspected Sites
» Alldata recorded and charts created using Excell'?




Mine and Timber Study Sites

Locations of sites used in east TN, with Knoxville as a reference
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Figure 7 Map depicting general geographic locations and clusters of sites,

with Knoxville as a reference




Methods

DBH and Tree Species

» Method of collection
» Standard FIA practices — DBH tapes
» Fverytree>1.1" in diameter

®» Species Count

» Analyzed with Kruskal-Wallis test

» Basal Area

» Calculated with formula: Basal Area = DBH? * 0.005454
» Aboveground biomass

» Analyzed using equations from Chojnacky et al. 2014

» Nearest taxonomical relative used for species not explicitly listed



Methods

Canopy Cover

» Method of collection

» App called CanopyCapture

» Recommended and tested against standard methods
» Collectfion

» Tested three times per subplot, on each subplot

» Analyzed with Kruskal-Wallis test by subplot




Methods

Water Infiltration Rate and Soil Density

» Method of collection

» Two Parts Figure 8 Single Ring and Density Tube, PBB
» |) Water Infiltration

= Single Ring Method(12)

» ?) Soil Density

» Collected using PVC tube; volume known
®» Process
» Two infiltration tests/subplot, one dry, one wet

» Density sample collected after wet infiltration

®» Two samples per subplot (5.9cm and 17.9cm)




Methods

Warter Infilfration Rate and Soil Density cont.

®» Processing Soil Samples

= Roots were pulled from each soil sample and dried
®» Dried samples were massed

® This is to examine root mass as another variable, and a function of belowground
biomass (Supporting).

» Eqach soil sample was oven dried after removing and recording volume of rocks

®» Dry sample was massed
» |nfiltrafion Times

» Recorded in seconds, and rate calculated to millimeters per second (mm/s)




Figure 9 Bug Sample Storage, PBB

Methods

Insect Biomass

» Method of Collection

» Simple pitfall trap @

» 80z. Cup, ~4 oz. propylene glycol, leave for 28 days

®» | frap per subplot

» Collection and Storage

. . Figure 10 Miller, Summer
» Storage in 95% ethanol solution for measurement 2022

®» Processing
» Samples were drained via sievellé)

» Sorted by flying insect vs. non-flying insect vs. non-insect and then massed

» Non-insect was omitted from analysis as method focused solely on insects




Methods

Decomposition Rate

» Method of Collection
» Tea Bag Index (TBI) test(!)
» Pairs of green and rooibos tea bags, 2g of tea each

» | pair per subploft, leave for 90 days

®» Processing

» Dried, roots removed, then massed

» Analyzed using equations from Keuskamp et al. 2013

Figure 11 Retrieved Tea Bags, PBB




Results

General

All data tested for normal distribution using Shapiro-Wilk

» Non-normal data tfransformed to meet assumptions of normality where possible

» Square root fransformation for Basal Areaq, transformTukey!'4 function for all else
Data modeled using two-way ANOVA against Site Type and Age Class

®» Flevation was included for all models as a covariate

» One way ANOVA models used for variables with interaction between
factors

» Usually by Age Class unless it was not significant

» Variables with significant variation were analyzed with a Duncan post hoc
test (not shown here, still being consolidated)

» All data analysis conducted using SASU17) & R Programming/(e- 10. 14,15, 16.19)



Results

Infiliration Rate

» Notf normally distributed (W= 0.4501, p= 2.2e-16)

» Transformed according to tfransformTukey function; raised to A
» \= 0.05, W=0.9707, p=0.03%96; almost normal
» Q-Q and Denisity Plots appeared good, so ANOVA proceeded

» Significant interactions between Site Type and Age Class (p=0.0461); split
out by Site Type

» Age Class significant on Mine Sites (p= 6.82e-4), not significant on Clearcut (p=
0.310)

» General upwards trend, differs significantly by 4th age class, but only 15t age
class different from controls
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Figure 12 Average infiltration rate for each age class on mine and
\ controlsites. Bars denote standard error. Different letters indicate
: statistical differences between disturbance types at P < 0.05.
\ Asterisk indicates significant difference from control at P < 0.05.




Results
Soil Density

» Density 15" Layer
= Not normally distributed (W=0.0846, p=2.2¢e-16)
» Qutlier removed, and data transformed (A= 0.4, W= 0.9794, p= 0.0681)
» Significant Interaction between Site Type and Age Class (p= 0.0103); split out

» Age Class significant on Mine sites (p=0.0348); not significant on Clearcut (p=0.314)

» General downwards trend on mine sites, only significant between 15t and 4th age
classes

» Density 2nd Layer
» Removed outlier, data normally distributed (W=0.9794, 0=0.1917)
» Not significant to Age Class or Site Type (p=0.5447 and p=0.3197, respectively)
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Figure 13 Average first layer soil density for each age class on mine,
clearcut, and confrol sites. Bars denote standard error. Different
letters indicate stafistical differences between disturbance types atf
P < 0.05. Asterisk indicates significant difference from control at P <
0.05.
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Figure 14 Average second layer soil density for each age class on
mine, clearcut, and control sites. Bars denote standard error.
Different letters indicate statistical differences between
disturbance types at P < 0.05. Asterisk indicates significant
difference from confrol at P < 0.05.



Results

Root Mass

» Root Mass 15t Layer
= Nof normally distributed (W=0.7485, p=2.16e-11)
» Data fransformed (A= 0.2, W= 0.9903, p= 0.7291)
» No significant interaction between Site Type and Age Class; no need to split
» Charts appear odd, split anyway; Age class on Mine sites significant (p=0.00102)

» Noft significant on Clearcut (p=0.5556)
» Gradual upwards trend on mine sites, significant around the 3@ age class
» Roof Mass 29 Layer
» Not normally distributed (W=0.7693, p=7.72e-11)
» Data fransformed (A= 0.225, W= 0.9829, p= 0.2565)
» Significant Interaction between Site Type and Age Class (p= 0.0228); split out
» Age Class significant on Mine sites (p=3.26e-7); not significant on Clearcut (p=0.735)
» Very gradual but noticeable upwards frend on mine sites, sudden spike in final age class




B

0.2
A AB

0 0.1 i
—

C
| iAB CI
3 4

Age Class

B Control M Mine M Clearcut

Figure 15 Average first layer root mass for each age class on mine,
clearcut, and conftrol sites. Bars denote standard error. Different
letters indicate statistical differences between disturbance types at
P < 0.05. Asterisk indicates significant difference from control at P <
0.05.
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\ difference from control at P < 0.05.




Results

Insect Mass

» (Non-flying)Insect Mass
» Not normally distributed (W=0.7573, p=1.71e-9)
» Data fransformed (A= 0.275, W= 0.9925, p= 0.9503)
» No significant interaction between Site Type and Age Class; no need to split
» Site Type individually significant (p=7.2e-4), Age Class not significant (p=0.2137)

= Post hoc test examines Site Type
» Total Insect Mass (includes ground and flying insects)
= Not normally distributed (W=0.8231, p=8.88e-8)
» Data fransformed (A= 0.325, W= 0.9872, p= 0.6874)
» Significant Interaction between Site Type and Age Class (p= 0.0199); split out
» Age Class not significant on Mine sites (p=0.0584); not significant on Clearcut (p=0.116)

» Post hoc examines differences in Site Type overall

» Clearcut sites have significantly more insect mass than surface mined sites overall
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Figure 17 Average of flying and non-flying insect mass by site
type. Bars indicate standard error. Different letters indicate
statistical differences between disturbance types at P < 0.05.



Results

Decomposition

» Only significant by site type (p=0.0131)

» Clearcut and Mine sites only significant difference (p=0.0064)

» Of note: Decomposition Rate on mine sites greater overall than on clearcut
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Figure 18 Average decomposition rate on mine, clearcut, and
control sites. Bars denote standard error.



Results

Canopy Cover

» Split out by Site Type to analyze change in Age Class; two Kruskal Wallis
Tests

Mine sites were significant by age class (x2=107.68, p<2.2e-16)

» Changes over time significant until 10-15 years post-disturbance

» Clearcut sites were also significant by age class (x2=19.818, p=0.001352)

» Canopy closes much sooner, within 5-10 years post-disturbance
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Figure 19 Average canopy cover for each age class on mine,
clearcut, and confrol sites. Bars denote standard error. Different
letters indicate statistical differences between disturbance types at
P < 0.05. Asterisk indicates significant difference from control at P <
0.05.



Results

Basal Area, Species Composition, Species Count, Trees Per Acre

» Trees Per Acre proved non-significant.

Species count showed significant differences between disturbance types (x2 =
99, H=6.23), but not between age classes (x2=11.07, H=9.06).

Species Composition results were varied.

» Yellow-poplar (Lirodendron tulipifera) dominated on clearcut sites until final age class,
then red maple (Acerrubrum)

» Black locust (Robinia pseudoacacia) most common on surface mined sites, along with
yellow-poplar.

» Maple and beech (Fagus grandifolia) most common on control sites, along with oak.

» Basal Area was significant in the interaction between site type and age class
(p<0.0001), therefore split out by site type.

» Significant on mine sites (p<0.0001), and on clearcut sites (p=0.0003)
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Figure 20 Species composition by basal area on (a) 230-
year-old surface-mined sites, (b) 230-year-old clearcut
sites, (c) control sites. Predominant species were
American beech (Fagus grandifolia), black oak
(Quercus velutina), blackgum (Nyssa sylvatical),
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maple (Acer rubrum), scarlet oak (Quercus coccineq),
sourwood (Oxydendrum arboretum), sugar maple
(Acer saccharum), sweetgum (Liquidambar styraciflua),
white oak (Quercus alba), and yellow-poplar
(Lirodendron tulipiferal).
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Results

Aboveground tree Biomass

» Significant by Age Class (p<2e-16) and Site Type (p=4.06e-14)
» Also significant by interaction between Site type and Age Class (p=0.000495)

Significant change in Age Class on Mine sites (p=5.53e-14)

» Positive changes with a steadily upwards tfrend, no significant difference
between controls and final age class (p=0.58703)

» Significant change in Age Class on Clearcut sites as well (p<2e-16)

» Everything age class significantly different from one another except 2nd and 3
(0=0.6228) and 4th and 5™ (p=0.7020); plateaus at these age classes, but other

wise positive growth

» Final age class is different from controls (p=0.0344), implying room for more
growthe
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Conclusions
Hypotheses

®» ]) One or more of the examined ecosystem services will show a significant and
consistent change according as age class increases.

» Fail fo Reject: Infiltration Rate, Density 15t Layer, Root Mass 15" & 2"d Layer, Canopy Cover,
Aboveground tree Biomass*, Average Basal Area*, Species Composition®

» Reject: Insect Mass & Total Insect Mass**, Decomposition Rate™*, Trees Per Acre, Species
Count

» ?2)Ecosystem services in question will not vary significantly from one another
across disturbance (site) types.

» This hypothesis is rejected across all variables

» 3)Potential ecosystem service metrics will not show significant variation between
control sites and the final age class.

» This hypothesis was not rejected by any relevant variable save Aboveground tree
Biomass and Average Basal Area on Clearcut sites




Discussion

Breakdowns, Exceptions, and Qualifiers

» *Surface Mining Control and Reclamation Act of 1977

» Afleast one surface mined site in the final age class reclaimed pre-SMCRA
» FRA Practices(® ?)

» Two surface mined sites in the third age class

» **Jncontrollable complications

» Sample Loss, Site Availability, Site Accessibility

» Fyuture studies, repeat studies, and follow ups
» Soil Sampling/Testing, Later study
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